1. Preparing to View the Installation Guide

This section describes how to view your installation guide from the Product Installation CD-ROM.

The topics covered in this section are:

- System Requirements
- Mounting the CD-ROM
- Running the Oracle Documentation Viewer

See Also: For information about the contents of your Oracle package, see Getting Started with Oracle7 for UNIX. The Getting Started document also describes the Oracle online documentation available on your CD-ROMs and ways of accessing other online documents.
System Requirements

The minimum system requirements to view online documentation on Intel SVR4 UNIX are:

- at least 24 MB of system RAM
- at least 50 MB of hard disk space
- a CD-ROM drive

If you later want to install the installation documentation and the documentation on the Product Documentation Library CD-ROM onto your system, follow the instructions in Chapter 4, “Installation Tasks”, in the Oracle7 Installation Guide for Intel SVR4 UNIX.
Mounting the CD-ROM

CD-ROM support is in Rockridge format for Data General, Solaris Intel and UnixWare operating systems. CD-ROM support is in ISO 9660 format for NCR and Unisys U6000 operating systems.

Note: The following instructions assume your mount point name is /cdrom. If not, replace all occurrences of /cdrom with the name of your mount point.

To mount your CD-ROM drive, perform the following steps:

1. Log in as root:

   $ su root
   Password:

2. Create an empty CD-ROM directory (the “mount point directory”) for mounting the CD-ROM drive and set the permissions to make it accessible by all users:

   # mkdir /cdrom
   # chmod 777 /cdrom

3. Create an Oracle link directory and set the permissions to make it accessible by all users:

   # mkdir /olink
   # chmod 777 /olink
4. Insert your CD-ROM into the CD-ROM drive and mount it to the mount point directory by entering the following:

**For Data General:**

```
# /etc/mount -t cdrom -o ro, noversion
/dev/pdsk/devicename /cdrom
```

**For NCR:**

```
# /etc/mount -F cdfs /dev/cdrom /cdrom
```

**For Solaris Intel:**

```
# mount -F hsfs -r /dev/dsk/c0t6d0p0 /cdrom
```

**For Unisys U6000:**

```
# mount -F cdfs -r /dev/arc0 /cdrom
# cdmntsuppl -c -F ugo+rx /cdrom
```

**For UnixWare:**

```
# mount -F cdfs -r -o fperm=777 /dev/cdrom/devname /cdrom
```

**Note:** You must have root privileges to mount or unmount the CD-ROM. Be sure to unmount the CD-ROM before removing it from the drive. You may unmount the CD-ROM after you run the startup script described in Step 8.

5. Log out of the root account:

```
# exit
```
6. Log in to a user account that has the required amount of space and memory (see the preceding section, “System Requirements”):
   login: user_account
   Password:

7. Change directories to the CD-ROM:
   For UnixWare, Solaris Intel and Data General:
   $ cd /cdrom/orainst
   For NCR and Unisys:
   $ cd /cdrom/ORAINST

8. Run the startup script:
   For UnixWare, Solaris Intel and Data General:
   $ ./start.sh
   For NCR and Unisys:
   $ ./START.*

When prompted, enter the name of the directory to which you will link (/olink). The startup script provides links from UNIX filenames in the Oracle link directory to filenames on the CD-ROM. It also copies the InstallationGuide and other Intel SVR4 UNIX-specific documentation onto your file system.
9. Go to the directory containing the Oracle Documentation Viewer on your CD-ROM file system:

For NCR, Solaris Intel, Unisys and UnixWare:

$ cd /olink/orainst

For Data General:

$ cd /cdrom/orainst
Running the Oracle Documentation Viewer

The Oracle Documentation Viewer is available in two forms:

- **oradocm** for Motif or Windows workstations
- **oradoc** for character mode terminals

The character mode version and the Motif versions are similar, with some navigational differences due to availability of the mouse in Motif.

**Motif**

Follow these steps to run the Oracle Documentation Viewer under Motif or OpenWindows:

1. Set the DISPLAY environment variable to your workstation identifier.
   - For Bourne shell or Korn shell, enter:
     
     ```
     $ DISPLAY=display_name; export DISPLAY
     ```
   - For C shell, enter:
     
     ```
     % setenv DISPLAY display_name
     ```
2. To run the Oracle Online Documentation Viewer, enter:

```
$ ./oradocm
```

The Oracle Documentation Viewer starts and opens the CD Contents Directory on your screen.

**Character Mode**

Follow these steps to run the Oracle Documentation Viewer in character mode:

1. Set the ORACLE_TERM environment variable to identify your keyboard type from the list below:

<table>
<thead>
<tr>
<th>To Run:</th>
<th>Set ORACLE_TERM to:</th>
<th>Access the menu with:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI terminal</td>
<td>ansi</td>
<td>F5</td>
</tr>
<tr>
<td>AT386 console</td>
<td>386</td>
<td>F5</td>
</tr>
<tr>
<td>AT386 xterm</td>
<td>386x</td>
<td>F5</td>
</tr>
<tr>
<td>UnixWare Terminal</td>
<td>386u</td>
<td>F5</td>
</tr>
<tr>
<td>Solaris Intel xterm</td>
<td>386s</td>
<td>F5</td>
</tr>
<tr>
<td>AVION Terminal</td>
<td>avx3</td>
<td>KP-0</td>
</tr>
<tr>
<td>Data General 200</td>
<td>dp2</td>
<td>KP-0</td>
</tr>
<tr>
<td>Data General 400</td>
<td>dp4</td>
<td>KP-0</td>
</tr>
</tbody>
</table>
To Run: | Set ORACLE_TERM to: | Access the menu with:
---|---|---
IBM High Function Terminal and axiTerm (monochrome) | hft | F8
IBM High Function Terminal and axiTerm (color) | hftc | F8
hpterm terminal emulator and HP 700/9x terminal | hpterm | F4
IBM 3151 terminal | 3151 (for IBM) | F8
SGI IRIS console | iris | F5
NCD X Terminal with vt220 style keyboard | ncd220 | F14
cmdtool/shelltool using a type 4 keyboard | sun | F7
cmdtool/shelltool using a type 5 keyboard | sun5 | F7
ANSI terminal for Tandem | tandm | F8
vt100 terminal | vt100 | KP-0
vt220 terminal | vt220 | KP-0
Wyse terminal | wyse | F5
To Run: | Set ORACLE_TERM to: | Access the menu with:
---|---|---
`xterm` using a type 4 keyboard | `xsun` | F7
`xterm` using a type 5 keyboard | `xsun5` | F7

For the Bourne shell or Korn shell, enter:

```bash
$ ORACLE_TERM=vt100; export ORACLE_TERM
```

For the C shell, enter:

```bash
% setenv ORACLE_TERM vt100
```

2. To run the Oracle Online Documentation Viewer, enter:

```bash
$ ./oradoc
```

The Oracle Documentation Viewer starts and opens the *CD Contents Directory* on your screen.
2. Viewing the *Installation Guide* Online

This section describes how to view, browse, and print the online installation guide and other Intel SVR4 UNIX-specific documentation.

The topics covered in this section are:

- Viewing the installation guide online
- Browsing the installation guide
- Printing the installation guide

*See Also:* *Getting Started with Oracle* for UNIX for detailed information on viewing or browsing Oracle online documents.
Viewing the Installation Guide Online

Note: The following sections assume you have followed the instructions in the previous section of this booklet: you have run the Oracle Documentation Viewer and have the CD Contents Directory document open on your screen.

You can view the installation guide and other Intel SVR4 UNIX-specific documentation by selecting the title as follows:

Motif: Double-click on the document title.

Character mode: Tab to the desired title. Press [ESC]-1 or [KP-0] to access the menu. Press N to bring down the Navigate menu. Press F to issue the Follow link command.

Warning: If you attempt to open a document that is not available you will get the following message:

OBV-1081: The file for document Document-ID is not on any bookshelf. Please add this document to a bookshelf and try again.

Select “OK” and choose the desired title.

Note: Do not create or modify a bookshelf until the online documentation is installed.
Browsing the Installation Guide

The button bar appears at the top of the open online document. It contains accelerator buttons for these functions:

- Next and Previous Page
- Next and Previous Chapter
- Go Back Command
- Table of Contents
- Find Command
- Add Text Annotation Command

Using Help

The help system contains the user’s guide for the documentation viewer. You can access the online help system at any time:

Motif: From the Help menu, select the Help System menu item.

Character mode: Press the [F1] key. If ORACLE_TERM is set to vt100, [ESC]-h accesses the online help system.
Using the Table of Contents

To use the table of contents or to jump to a document chapter or subheading:

1. Access the Table of Contents.
   
   **Motif:** Click on the (Contents) button from the button bar or use the Select mouse button to select the Table of Contents menu item from the Windows menu.

   **Character mode:** [ESC]-1 or [KP-0] to access the menu; press W to access the Windows menu, then press T to select the Table of Contents menu item, and press [RETURN].

   Only the top-level headings are visible in the list box.

2. Expand the list (optional).

3. Select an item in the Table of Contents.
   
   **Motif:** Double-click on the item.

   **Character mode:** Use Down Arrow and [RETURN].
Using the Index

To search for indexed entries in the installation guide and other Intel SVR4 UNIX-specific documentation:

1. Access the Index dialog box:
   - **Motif**: Use the Select mouse button to select the Index menu item from the Windows menu.
   - **Character mode**: \[ESC\]-1 or [KP-0] to access the menu; press W to access the Windows menu, then press I to select the Index menu item, and press [RETURN].

2. Select and open the index item you want:
   - **Motif**: Double-click on the item.
   - **Character mode**: Use the Down Arrow and [RETURN].
Using the Find Menu

To search for a specific subject:

1. Access the Find dialog box:
   
   **Motif:** Click on the *(Find)* button from the button bar or use the Select mouse button to select the Find menu item from the Windows menu.

   **Character mode:** [ESC]-1 or [KP-0] to access the menu; press W to access the Windows menu then F to select the Find menu item, then [RETURN].

2. Enter the search criteria in the Find field.

   You can search for a single word or phrase, or perform a wild card search. For example:

   - Installer (single word search)
   - Oracle Installer is (phrase search)
   - Inst% (wild card search)

3. Choose the *(Find)* button to execute the search. Text that matches the search criteria appears in the scroll box.

   **Motif:** Double-click on the *(Find)* button.

   **Character mode:** Tab to the *(Find)* button and press [RETURN].
4. To see a matching entry in detail, select and open it from the scroll list.

   **Motif**: Double-click on the item.

   **Character mode**: Tab to the Match list, then use the Down Arrow and [RETURN] to select the entry.

**Using the Navigate Menu**

The Navigate menu contains menu items that allow you to easily move around a document:

- You can choose to jump to the next (or previous) chapter, page, or bookmark.
- If you get lost in a document, the Go Back menu item or accelerator button retraces your steps by going back through the hypertext links that you used.
Printing the Installation Guide

This section describes how to choose a printer and print the installation guide and other Intel SVR4 UNIX-specific documentation.

Choosing a Printer

Because you have not yet installed Oracle7 Server on your system, you do not have the printer setup files needed to define a printer for the Documentation Viewer. Instead, you must specify a printer during your current UNIX session, and then start the Documentation Viewer from that session:

1. Check that the DISPLAY variable is set to your current workstation:

   $ echo $DISPLAY

2. Use the TK2_PRINTER variable to identify a printer:

   For the Bourne or Korn shell, enter:

   $ TK2_PRINTER=your_printname; export TK2_PRINTER

   For the C shell, enter:

   % setenv TK2_PRINTER your_printname
3. Re-start the Oracle Online Documentation Viewer:

    $ ./oradocm

4. Check that your printer is recognized by the Documentation Viewer. Select the Choose Printer menu item from the File menu. The Printer Chooser dialog box appears, displaying the printer name in the Printer Name box.

5. Click on the (OK) button.

Printing the Online Documents

Use the following procedure to print online documents:

1. Select the Print menu item from the File menu. The Print dialog box appears.

2. From the Document menu, choose the online document you want to print.

3. Under the Print Choices options, turn on the (Document) button.

4. Under the Print Range options, choose Entire Document, Current Selection, or Chapters (with the chapters you want to print selected from the scroll list).

5. Click on the (Print) button.
You now have access to the Intel SVR4 UNIX-specific documentation. Continue with your Oracle installation.